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Allegro General Questions

How do I determine which version of software is installed on the Allegro?

The software version is listed in the About window of each AI software. For example, start
CeCi and then tap View > About CeCi. The first line of information identifies the software
version as shown in the next example. 

How do I get the latest version of software available for the Allegro?

Contact Technical Services at pcstechservices@aiworldwide.com for a User Name and
Password to access files for download. 

How much storage space is on the Allegro? 

The Allegro MX is available with different sizes of internal SD memory cards, up to 32GB in
size. The Allegro MX also supports a USB flash drive. Plug the USB flash drive in the USB
port if you want to transfer files to and from the Allegro. 
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What can I do if the Allegro will not power up? 

If the Allegro will not power up, try the following solutions: 

• Check the battery and charger.

Verify the battery has enough charge to power up the Allegro. Also verify the
charging cable or docking station provides sufficient power to charge the Allegro. 

Use a voltmeter to verify the voltage output of the battery is at least 3.6 volts. If the
voltage output is less than 3.4 volts, you may need to purchase a replacement
battery. To help maintain the battery, plug the Allegro (or power dock) in a power
source when not in use, such as each night and weekend. 

• Reset the software (warm reboot).

To perform a warm reboot, press and hold the On/Off power button for 5 to 7
seconds. Press Reset when the Power window displays. 

• Reset the hardware and restore the software (cold reboot).

To perform a cold reboot, press and hold the On/Off power button for 20 seconds.
When the Power window displays, continue pressing the power button until the
Allegro resets automatically. The display will then flash and the Allegro will begin
reloading the operating system. 

If a cold reboot does not solve the problem, turn off the Allegro and then disconnect
it from any external power source (wall charger or power dock). Remove the battery
pack inside the Allegro. After at least 30 minutes, reinstall the battery pack and then
plug the Allegro in an external power source. Charge the battery for at least five
minutes and then turn on the Allegro. 
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What is the best power-saving method for the Allegro?

The following power options are available with the Allegro: 

• Suspend Mode: Press the On/Off key on the Allegro keypad to place the Allegro in
suspend mode. Use this power option during the majority of day to day operation.
The Allegro uses a small amount of power during suspend mode, even when the
touchscreen is off. When the Allegro is turned back on, suspend mode returns to the
most current state. 

• Power Off: To turn the Allegro off and stop the battery from discharging power,
press and hold the On/Off power button for two seconds. When the Power window
displays, tap Power Off. Use Power Off when the Allegro is not in service for an
extended period of time.

What can I do if the Allegro battery drains completely?

• Reset the Allegro. 

To reset the Allegro, press the power button for 8 seconds to display the Power
window and select Reset. This applies default settings to the Allegro, including GPS
Pod Setup. Run GPS Pod Setup to re-configure GPS communication settings.
Resetting the Allegro can also clear any other problems, such as unresponsive
software. 

• Tapping the power button once places the Allegro in sleep mode. Tapping the
button again turns on the Allegro. Use this method frequently to conserve battery
power.

• If you plan to store the Allegro for a month or more, press the power button for 8
seconds to display the Power window and select Power Off. 
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I have a Trimble GPS receiver connected to the Allegro with successful
communication established between the two. Why does the Allegro show HiLo
mode instead of GPS mode? 

Using an external GPS receiver with the Allegro is referred to as dual GPS. Although the
Allegro and external GPS are communicating, the following items must also be set up on
the Allegro: 

• GPS patch antenna is plugged in the GPS ANT connector on the Allegro. 

The Allegro includes an internal GPS module that uses the patch antenna to acquire
a GPS timing signal from the satellite. If the GPS timing signal is unavailable, the
Allegro operates in HiLo mode instead of GPS mode. 

• GPS Pod Setup is set correctly for dual GPS. Tap Start > File Explorer > My Device >
Storage > Program Files > GPSPodSetup and verify settings match those shown in
the next figure. 

• GPS Status is set correctly for dual GPS. Tap Start > GpsStatus > Options and verify
settings match those shown in the next figure. 
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How do I enlarge the font size or change the touchscreen brightness and contrast
settings?

To increase or decrease the font size:

1. Tap Settings > System tab > Screen > Text Size tab.

2. Move the slider to increase or decrease text size. To change text size and font in a PS 
survey file tap View > Fonts. 

To change the backlight brightness

1. Tap Settings > System tab > Backlight > Brightness tab. 

2. Press <Orange> <F5> keys simultaneously to increase the contrast and brightness. 
To decrease the contrast and brightness, press <Orange> <F4> keys 
simultaneously.

How do I find the version number of the DVM card?

To determine the version of the DAQ card:

1. Run any of the AI Allegro software. For example, tap Start > AIDvm. 

2. Tap Options > About tab to display the About window and view the DAQ card 
version. The voltage range supported by the various DAQ cards is identified in the 
following list: 

• 150V maximum: DAQ FF and DAQ 0B

• 250V maximum: DAQ 08, DAQ 09, and DAQ 0A

Based on the version of the DAQ
card, AI Allegro software reads
and sets the maximum voltage as
150V or 250V. 
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Can I start AI software using the Allegro keypad instead of the Start menu?

After deleting the Key Redirect shortcut in the Allegro Startup folder, you can then map
any AI software to any of the F1 through F5 function keys. Using these function keys in
this manner allows you to start an AI software with a single button press. 

I programmed Allegro MX function keys to open AI software, now they do not
work. 

Delete the Key Redirect shortcut in the Allegro Startup folder to restore functionality to F1
through F5. 

To delete the Key Redirect shortcut, follow these steps: 

1. Tap Start > File Explorer > Windows > Startup.

2. Tap and hold the KeyRedirect shortcut to display a shortcut menu, and then tap 
Delete. 

Note: Key Redirect reprograms the F1 through F5 keys. The Allegro ships with Key
Redirect factory-installed.
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How can I verify interruption or make timing adjustments to ensure the Allegro is
capturing the correct Structure P/S and Structure IRF at the correct time?

Start the AiDVM software and then complete the following steps:

1. Tap Options > On/Off tab > Enable On/Off mode. 

2. Set on/off settings and then tap OK. 

3. Tap Graph to view a waveform of on/off readings as shown in the next example.

What can I do if I cannot get a GPS satellite fix?

Verify the following settings are correct: 

• Run the GPS Status software and verify COM port settings are correct. 

• Run the GPS Pod Setup software and verify settings are correct. All software must be
closed before viewing settings in GPS Pod Setup. 

• Verify the GPS antenna has a clear view of the sky and is securely connected to the
Allegro.
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Why are GPS coordinates not recording in my Periodic Survey file?

Verify the cursor is in a reading field in the bottom pane of the survey file. Tapping a
reading field places the cursor in the field. 

Why is the Insert GPS command unavailable for selection in the Periodic Survey
software?

Verify the GPS Status software is running and the cursor is in a reading field in the bottom
pane of the survey file. Tapping a reading field places the cursor in the field. 

Why does CeCi switch to Hi-Lo mode when my survey file is set up with GPS Sync or
GPS Real-Time mode?

CeCi automatically switches to High/Low mode when the Allegro loses the internal GPS
time signal. When setting up a survey file in GPS Sync or GPS Real-time mode, AI
recommends that you also set up the survey file in High/Low mode. 

Why do on/off readings look incorrect in CeCi?

• Run the AiDvm software and view the waveform graph. Use the graph to verify
satellite communication and on/off settings are correct. 

• View the AiDvm waveform graph several times before taking survey readings. This
allows you to change on/off delay times as needed to get the best on/off capture. 
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How do I include Remarks and GPS coordinates in a CeCi survey file when using
Skip/Lock/Normal mode?

The following procedure applies to a CeCi survey set up in Fixed Increment mode. If you
want to view the center line (CL) in a skipped section, verify the survey file is also set up
with the option Retain Skipped records in Skip Mode (View > Options > File tab). 

Complete the following steps:

1. Place the cursor in the pipe-to-soil (P/S) field and then press <Ctrl> <Z> or tap 
Move > Skip/Lock/Normal. 

Pressing <Ctrl> <Z> toggles Skip, Lock, and Normal modes. In Skip mode, CeCi
inserts (SKIP) in the Remarks field of the selected survey record. 

2. Move the cursor to the Remarks field by tapping the field or pressing the Tab 
button (right arrow). 

Indicates SKIP mode.

Displays (Skip), (Lock), or empty field/normal mode. 

Remarks Field
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3. Tap Remark to open the Remarks window. Select and then double-tap the remark to 
insert it in the survey record and close the window. 

4. Press Enter to move the cursor to the P/S field.

5. Press the down arrow to move the cursor to the next station number (SN). Continue 
to survey to the other end of the SKIP (such as a road crossing, railroad crossing, 
exposed pipe, and so on).
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6. Press <Ctrl> <Z> to toggle from SKIP to normal mode. Move the cursor to the 
Remarks field and add another remark.

7. Press Enter and then the down arrow to move to the next SN and take a reading. 

The survey file contains information shown in the next image, including GPS coordinates
when using GPS. 

Beginning of skip section.

End of skip section.
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Caps Toggle <Blue><Caps Lock> Toggles caps lock on and off.

Display Backlight <Orange><F3> Toggles backlight on and off.

Display 
Brighten/Dim

<Orange><F4>
<Orange><F5>

Brightens or dims the screen 
display. Select ORANGE shift 
key then F4 to dim, or F5 to 
brighten.

Move Between 
Fields and Buttons

<TAB> Move cursor between fields 
and buttons. Left tab arrow 
moves cursor backward; right 
tab arrow moves cursor 
forward.

Move from One Tab 
to Another

<Ctrl><TAB> Move from one tab to another 
in a window with multiple tab 
pages. 

Open Drop-down List <Alt><Down Arrow> Press <Alt> and down arrow to 
open drop-down list.

Touchscreen <Blue><TS> Enable or disable touchscreen.

Task Manager <Blue><Esc> Open Task Manager.

Close Window <Esc> Close an open window.

Windows Start Menu Open Start menu.

Graph <G> or <Alt><G> Open graph.

Copy / Paste <Ctrl><C>

<Ctrl><V>

Copy current DVM reading. 

Paste DVM reading in an open 
file, such as Excel. 

Option Window <N> or <Alt><N> Open Options window. 

Voltage Range <Ctrl><Up Arrow>
<Ctrl><Down Arrow>
<U> or <Alt><U>

Increase voltage range.
Decrease voltage range.
Select autoranging. 

VDC Test Function <D> or <Alt><D> Select Vdc test function.

VAC Test Function <A> or <Alt><A> Select Vac test function.

Amp Test Function <M> or <Alt><M> Select Amp test function.

Ohm Test Function <O> or <Alt><O> Select Ohm test function.

Diode Test Function <I> or <Alt><I> Select Diode test function.

Move Cursor Between 
Fields

<TAB> Press <TAB> to move cursor 
from one field to another in 
DVM Options window. 

Move Cursor in Drop-
down List

<Up/Down Arrows> Press up/down arrows to move 
cursor up and down in a drop-
down list in DVM Options 
window.

Enable or Disable 
Autoranging

<A> Press <A> to enable or disable 
autorange option in DVM 
Options window. 

Global Shortcuts

AiDVM

Accept Selection in 
Drop-down List

<Enter> Press <Enter> to accept 
selection in a drop-down list in 
DVM Options window. 

Move Cursor to 
Sample Rate Field

<S> Press <S> to move cursor to 
Sample Rate field in DVM 
Options window.

Display Graph 
Remarks

<Tab>

<Enter>

Press <Tab> to move cursor to 
Save button in DVM graph 
window, then press <Enter> to 
display graph remarks window. 
Press <Enter> in graph 
remarks window to add a new 
line; press <Tab> to move 
cursor to Ok or Cancel and 
then press <Enter>.

New <Ctrl><N> Create new survey file.

Open <Ctrl><O> Open File Open window.

Save <Ctrl><S> Save survey file.

Flag Marker <F> Insert flag marker in flagged 
mode.

Reset Flag Count <Ctrl> <F> Reset flag count.

Gap Marker <G> Insert gap marker in flagged 
mode.

Capture Reading <Enter> Capture a reading.

First Record <Ctrl><Blue><Home> Move cursor to first record.

Last Record <Ctrl><Blue><End> Move cursor to last record.

Go To <Ctrl><G> Open Go To Location window. 

Skip <Ctrl><K> Open Skip Distance window in 
Fixed Increment mode.

Insert Record <Ctrl><Ins> Insert new record.

Delete Record <Ctrl><Del> Delete selected record.

Skip/Lock/Normal <Ctrl><Z> Toggles Skip, Lock, and Normal 
in Fixed Increment mode. 

Remark <Alt><R> Open remark window. 

Pause/Resume <Ctrl><P> Pause or resume timed 
readings. 

Test Point 
Information

<Ctrl><T> Open Test Point Information 
window. 

Open File Menu <Alt> <F> Press <Alt> <F> to open File 
menu. 

Open Move Menu <Alt> <M> Press <Alt> <M> to open 
Move menu. 

AiDVM

CeCi

Open View Menu <Alt> <V> Press <Alt> <V> to open View 
window. 

Open Remark 
Window

<Alt> <R> Press <Alt> <R> to open 
Remark window. 

Navigating Misc Tab 
in Options

<B>

<V>

<W>

<D>

Press <B> to enable or disable 
Beep on every Reading. 
Press <V> to move cursor to 
Voltage level. 
Press <W> to enable or 
disable Beep when overwrite 
existing data. 
Press <D> to enable or disable 
Enable double-click detection. 

Navigating File Tab in 
Options

<A>

<I>

<R>

Press <A> to enable or disable 
Autosave.
Press <I> to move cursor to 
Interval (minutes).
Press <R> to enable or disable 
Retain Skipped records in Skip 
mode. 

Navigating GPS Tab in 
Options

<C>

<S>

<G>

Press <C> to enable or disable 
Clear GPS Location After.
Press <S> to move cursor to 
Seconds Without Updates.
Press <G> to move cursor to 
GPS Display Format. 

Navigating Graph Tab 
in Options

<G>

<U>

<L>

<W>

Press <G> to enable or disable 
Show Graph. 
With Show Graph enabled: 
Press <U> to move cursor to 
Upper Value.
Press <L> to move cursor to 
Lower Value. 
Press <W> to move cursor to 
Width. 

Navigating Colors Tab 
in Options

<E>

<Tab>

<Up/Down Arrows>
<Home/End Arrows>

Press <E> to enable or disable 
Enable Color. 
With Enable Color enabled: 
• Press <Tab> to move cursor 

between field selection list 
and color grid.

• Press <Up/Down or Home/
End arrows> to move cursor 
in field selection list or color 
grid. 

Navigating Open and 
Save As Windows

<Tab>

<Up/Down Arrows>

Press <Tab> to move cursor 
between fields.
Press <Up/Down Arrows> to 
navigate list of files. 

CeCi
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Navigating GPS 
Status Window

<Tab>

<Enter>
<Up/Down Arrows>

Press <Tab> or <Up/Down 
Arrows> to move cursor 
between fields.
Press <Enter> to open or close 
a drop-down list. Press <Up/
Down Arrows> to navigate 
options in drop-down list and 
then press <Enter> to select an 
option. 
Press <Up/Down Arrows> to 
navigate list of files.

Enable/Disable Read 
PPS from Internal GPS

<P> Press <P> to enable or disable 
Read PPS from Internal GPS. 

Apply / Cancel 
Changes

<Ok> / <Cancel> Press <Ok> to apply changes 
or <Cancel> to cancel changes. 

Navigating GPS 
Status Window

<Tab>

<Enter>
<Up/Down Arrows>

Press <Tab> or <Up/Down 
Arrows> to move cursor 
between fields.
Press <Enter> to open or close 
a drop-down list. Press <Up/
Down Arrows> to navigate 
options in drop-down list and 
then press <Enter> to select an 
option. 
Press <Up/Down Arrows> to 
navigate list of files.

GPS Status

New <Ctrl><N> Create new survey file.

Open <Ctrl><O> Open File Open window.

Save <Ctrl><S> Save survey file.

Flag Marker <F> Insert flag marker in flagged 
mode.

Reset Flag Count <Ctrl> <F> Reset flag count.

Gap Marker <G> Insert gap marker in flagged 
mode.

Capture Reading <Enter> Capture a reading.

First Record <Ctrl><Blue><Home> Move cursor to first record.

Last Record <Ctrl><Blue><End> Move cursor to last record.

Go To <Ctrl><G> Open Go To Location window. 

Skip <Ctrl><K> Open Skip Distance window in 
fixed increment mode.

Insert Record <Ctrl><Ins> Insert new record.

Delete Record <Ctrl><Del> Delete record.

Remark <Alt><R> Open remark window. 

Test Point 
Information

<Ctrl> <T> Open Test Point Information 
window. 

DCVG

Open <Ctrl> <O> Open File Open window.

Save <Ctrl><S> Save survey file.

Copy, Cut, Paste <Ctrl><C>

<Ctrl><X>

<Ctrl><V>

Copy selection to clipboard.
Remove selection and copy to 
clipboard.
Paste content from clipboard.

Select Data in a Field <Shift><Blue><Home>

<Shift><Blue><End>

Select data from the current 
cursor location to the end of 
the field. 
Select data from the current 
cursor location to the 
beginning of the field.

Undo <Ctrl><Z> Undo last change.

Next Page / Previous 
Page

<Ctrl><Down Arrow>

<Ctrl><Up Arrow>

Display next page of a multi-
page site. 
Display previous page of a 
multi-page site. 

Next Site / Previous 
Site

<Shift><Down Arrow>
<Shift><Up Arrow>

Display next site. 
Display previous site. 

Record GPS 
Coordinates

<Ctrl><G> Records GPS coordinates when 
cursor is in reading field.

Insert GPS 
Coordinates

<Ctrl><I> Inserts GPS coordinates when 
cursor is in reading field. 

Capture Reading <Enter> Capture a reading. Options 
include:
• Select reading field and 

press <Enter> to activate 
digital voltmeter. Press 
<Enter> again to capture 
reading. 

• Select timed reading field 
and press <Enter> to set up, 
start, stop, or cancel timed 
reading mode.

Navigate Information 
and Reading Fields

<Alt> <U> Move cursor between 
information and reading fields. 

Open File Menu <Alt> <F> Open File menu.

Open Edit Menu <Alt> <E> Open Edit menu.

Open View Menu <Alt> <V> Open View menu. 

Cancel/Apply 
Changes

<Esc>/<Cancel> and 
<Enter>/<OK>

Cancel changes: press <Esc> 
or move cursor to <Cancel> 
button and press <Enter>.
Apply changes: press <Enter> 
when in a drop-down list or 
move cursor to <OK> and 
then press <Enter>.

Move Cursor in Drop-
down List

<Up/Down Arrows> Press up/down arrows to 
move cursor in a drop-down 
list.

Annual / Periodic Survey
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